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Getting Started
TestTrack’s scalable client/server model allows you to easily track andmanage projects from a central
location. Each TestTrack Server contains information about projects, the server log, server users, the
mail queue, and server options. The TestTrack Server Admin Utility is used tomanage these
components.

The TestTrack Server Admin Utility is generally installed on the server computer and the server
administrator’s computer. You add connections to the servers you want to administer.

Starting the Seapine License Server
The Seapine License Server must be running before the TestTrack Server or the TestTrack Server Admin
Utility are started.

n Windows—If the Seapine License Server is installed as a service, it starts automatically. If the
license server is installed as an application, choosePrograms > Seapine Software > Seapine
License Server > Seapine License Server from the Start menu.

n Mac—Click Seapine License Server in the System Preferences. If you want to set the server to
start automatically, click the lock and select Start Seapine License Server when this computer
starts up.

n Linux—Enter /usr/bin/spls start

If there is a problem starting the server, make sure the server computer is online, check the IP address
and port number, andmake sure you are connected to the network, intranet, or Internet.

Starting the TestTrack Server
The TestTrack Server must be running before you start the TestTrack Server Admin Utility.

n Windows—If the TestTrack Server is installed as a service, it starts automatically. If the server is
installed as an application, choose Programs > Seapine Software > TestTrack > TestTrack
Server from the Start menu.

n Mac—Click TestTrack in the System Preferences. If you want to set the server to start automatically,
click the lock and select Start TestTrack Server when this computer starts up.

n Linux—Enter /usr/bin/ttstudio start

If there is a problem starting the server, make sure the server computer is online, check the IP address
and port number, andmake sure you are connected to the network, intranet, or Internet.

Starting the TestTrack Server Admin Utility
Make sure the Seapine License Server and TestTrack Server are running before starting the TestTrack
Server Admin Utility.

Note: A default administrative user is created during installation. Log in as this user the first time you
start the TestTrack Server Admin Utility. The username is Administrator and there is no password.
To prevent unauthorized access, create a password for this user.
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Setting up server connections

1. Windows—ChoosePrograms > Seapine Software > TestTrack > TestTrack Server Admin
from the Start menu.

Mac—Double-click the TestTrack Server Admin Utility icon in the Applications/TestTrack folder.

Linux—Enter /usr/bin/ttadmin.

The TestTrack Server Admin Utility Login dialog box opens.

2. Select the Server you want to connect to. SeeAdding server connections, page 3 if you need to
add a server.

3. Enter yourUsername andPassword or select Use single sign-on to log in with your network
credentials.

Note: Single sign-on is only available forWindows andMac.

4. Click Connect.

The TestTrack Server Admin Utility starts.

Setting up server connections
The TestTrack Server Admin Utility connects to the TestTrack Server via TCP/IP. Projects are located
on a central TestTrack Server that is accessed by multiple remote client computers. Before you can
access a server, you need to add a server connection.

1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Click Add to create a server connection. SeeAdding server connections, page 3.

4. Select a server and click Edit to change the server address or port number. SeeEditing server
connections, page 3.

5. Select a server and click Delete to delete the connection.

6. Select a server and click Top,Move Up,Move Down, orBottom to reorder the list.

Youmay want to move the servers you access most frequently to the top of the list.

7. Click Close to close the Setup Server Connections dialog box.

2



Setting up server connections

Adding server connections
You need to add TestTrack Server connections to access projects.

1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Click Add.

The Add TestTrack Server dialog box opens.

4. Enter aServer Name.

Use a unique name to help users easily identify the server. For example, use your company name
instead of a generic name like server1.

5. Enter theServer Address of the computer the TestTrack Server application is installed on.

You can enter a domain name but a static IP address is recommended. The server admin utility uses
TCP/IP to connect to the server.

6. Enter thePort number.

TestTrack clients connect to the server on this port via TCP/IP. Valid values are 1-65535.

7. Click OK.

The server connection is added. You return to the Setup Server Connections dialog box.

8. To reorder the servers, select a server and click Top,Move Up,Move Down, orBottom.

Youmay want to move the servers you log in tomost frequently to the top of the list.

9. Click Close to close the Setup Server Connections dialog box.

Editing server connections
1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Select the server and click Edit.

4. Make any changes and click OK.
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Adding server users

Deleting server connections
1. Choose File > Connect to Server to open the login dialog box.

2. Click Setup.

The Setup Server Connections dialog box opens.

3. Select the server and click Delete.

You are prompted to confirm the deletion.

4. Click Yes.

The server is deleted.

Adding server users
Most companies generally limit access to the TestTrack Server Admin Utility to administrators or other
high-level users. All users, including server admin utility users, are created on the Seapine License
Server. Server users are not the same as project users and cannot automatically access projects.

1. ChooseView > Server Users.

The Server Admin Utility Users dialog box opens.

2. Select a user in the Available Users list and click Add.

You cannot set security permissions for admin utility users. Make sure you want the selected user to
have unrestricted access to the admin utility.

3. Click OK when you finish adding users.

Removing server users
1. ChooseView > Server Users.

The Server Admin Utility Users dialog box opens.

2. Select a user in the TestTrack Server Admin Utility Users list and click Remove.

The user can no longer access the server admin utility.

3. Click OK when you finish removing users.
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Connecting to a different server

Connecting to a different server
You can connect to a different server without closing the TestTrack Server Admin Utility. This command
is only used if the TestTrack Server is installed onmultiple computers.

1. Choose File > Connect to Server.

You are prompted to confirm that you want to disconnect from the current TestTrack Server.

2. Click Yes.

The login dialog box opens.

3. Select the Server you want to connect to.

4. Enter yourUsername andPassword.

5. Click OK.
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Creating Projects
TestTrack projects contain the information you track including issues, test cases, test runs,
requirements, requirement documents, security groups, users, customers, filters, test configurations, and
workbook tasks. Projects are defined on the TestTrack Server andmanaged using the TestTrack Server
Admin Utility. The TestTrack Server maintains the data for each project in a separate cache inmemory on
the server.

TestTrack supports TestTrack native and RDBMS projects. See the Choosing a TestTrack Database
Format knowledgebase article (www.seapine.com/kb/questions/1354) for information about each
database type.

Your use of projects depends on your company’s business processes. If you are using TestTrack to track
software issues, youmay want to create a project for each release, for feature requests, or for specific
customers. You can also customize TestTrack for other types of tracking. For example, you can
customize fields, terminology, and the workflow to help your human resources personnel track
employees.

Creating TestTrack native projects
TestTrack uses SQLite as the native backend database by default. All TestTrack native project files,
including the SQLite database file, are stored in a directory on the local hard drive of the TestTrack Server
computer or amapped network drive. Only one project is stored in each project database.

1. ChooseView > Projects.

The Projects dialog box opens.

2. Click Create.

The Create Project dialog box opens.

3. Enter aDescription.

This is the name displayed when users log in to TestTrack.
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Creating RDBMS projects

4. Select TestTrack Native from the Project Type list.

5. Enter aProject Directory name.

A project directory with this name is created in the TTServDb/TTDbs directory in the TestTrack
application directory by default. The project directory contains the project database file and
subdirectories for attachments, SoloBug files, and report stylesheets. The TestTrack Server may be
configured to use a different default path, which is displayed in the Location area. Youmay be able to
enter a full path depending on the server settings. The path cannot exceed 247 characters, including
the drive specifier (e.g., C:\) and names of subdirectories that TestTrack creates in the specified
directory.

Note: The default path for new projects and the ability to enter fully qualified pathnames is
controlled using the TestTrack Registry Utility. See the TestTrack Registry Utility Guide
(http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf) for information.

6. Select any Project Settings.

n Project is active creates an active project. Users cannot access inactive projects.

n Include project in Web login listmakes the project available in the TestTrack Web login list.

n Include project in Client login listmakes the project available in the TestTrack Client login list.

n Always compact the project when the TestTrack Server is started compacts the project
when the server starts. Compacting removes space and rebuilds the index files but may increase
initialization time.

n Compact the project the next time the TestTrack Server is started compacts the project the
next time the server starts.

7. Enter any project Notes. For example, you can enter notes about what the project is used for or why it
was created.

8. Click OK.

The project is created.

Creating RDBMS projects
You can store TestTrack projects in a Relational DatabaseManagement System (RDBMS). Using an
RDBMS allows you to distribute projects betweenmultiple databases if you have a large TestTrack
installation, leverage your existing database administration processes, and use standard database tools.

1. Create a connection to the RDBMS you want to store the project in. SeeSetting RDBMS
connection options, page 21.

2. ChooseView > Projects.

The Projects dialog box opens.

3. Click Create Project.

The Create Project dialog box opens.
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Creating RDBMS projects

4. Enter aDescription.

This is the name displayed when users log in to TestTrack.

5. Select RDBMS from the Project Type list.

6. Select theConnection for the RDBMS database you want to add the project to.

7. Enter a uniqueProject Name.

This is the name displayed for the project in the server admin utility.

8. Enter theProject Directory name.

A project directory with this name is created in the TTServDb/TTDbs directory in the TestTrack
application directory by default. The project directory contains subdirectories for attachments,
SoloBug files, and report stylesheets. The TestTrack Server may be configured to use a different
default path, which is displayed in the Location area. Youmay be able to enter a full path depending
on the server settings. The path cannot exceed 247 characters, including the drive specifier (e.g., C:\)
and names of subdirectories that TestTrack creates in the specified directory.

Note: The default path for new project directories and the ability to enter fully qualified pathnames
is controlled using the TestTrack Registry Utility. See the TestTrack Registry Utility Guide
(http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf) for information.

9. Select theProject Settings.
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Creating a project from a template

n Project is active creates an active project. Users cannot access inactive projects.

n Include project in Web login listmakes the project available in the TestTrack Web login dialog
box.

n Include project in Client login listmakes the project available in the TestTrack Client login
dialog box.

10. Enter any project Notes.

For example, you can enter notes about what the project is used for or why it was created.

11. Click OK.

A progress dialog box opens, displaying actions as the project is created. You return to the Projects
dialog box after the project is created.

12. If the connection does not contain any TestTrack tables, you are prompted tomanually or
automatically create them.

n Click OK if you want TestTrack to automatically create the tables. SeeAutomatically creating
TestTrack database tables, page 46.

n Click Cancel if you want to manually create the tables.

Note:We recommendmanually creating the tables. A DBA can perform capacity planning before
creating the database and tables, plan and implement database backup and recovery, implement
and enforce proper security for the database and tables, and configure the database and tables to
ensure proper performance andmaximum database stability. SeeSetting Up
RDBMS Databases, page 51.

Creating a project from a template
You can create a project based on an existing project. The new project is populated with users, security
groups, customers, filters, test configurations, and reports from the existing project. Issues,
requirements, requirement documents, test cases, test runs, and workbook tasks are not copied.

Note: Legacy TestTrack 2011.1 or earlier native projects must be upgraded before they can be used as
templates for new projects.

1. ChooseView > Projects.

The Projects dialog box opens.

2. Select the project you want to use as a template.

3. Click Create from Template.

The Create Project from Template dialog box opens.

4. Enter aDescription.

This is the name displayed when users log in to TestTrack.

5. Select aProject Type.

6. If you are creating a TestTrack native project, enter theProject Directory name.
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Creating a project from a template

If you are creating an RDBMS project, select theConnection for the database you want to add the
project to, enter theProject Name to display in the server admin utility, and enter theProject
Directory name.

A project directory is created in the TTServDb/TTDbs directory in the TestTrack application directory
by default. The project directory contains subdirectories for attachments, SoloBug files, and report
stylesheets. For TestTrack native projects, the directory also contains the project database file. The
TestTrack Server may be configured to use a different default path, which is displayed in the Location
area. Youmay be able to enter a full path depending on the server settings.

Note: The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names
of subdirectories that TestTrack creates in the specified directory.

7. Select theProject Settings.

8. Enter any project Notes.

9. Click OK.

The project is created.
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Configuring Server Options
TestTrack’s client/server design centralizes mail, logging, and other options and shares them across
projects.

Setting log options
The TestTrack Server creates log files that record events, such as severe errors or unusual activity, and
help youmonitor the server’s operation. The server can also send email notifications based on these
events.

SeeWorking with the Server Log, page 47 for information about viewing the server log.

1. ChooseView > Server Options.

TheOptions dialog box opens with the Logging category selected.

2. Select Log Options.

n TheWrite to server database level specifies the events written to the server database log.

n TheWrite to NT event log orWrite to Unix system log levels specify the events written to the
NT/2000 event log or the Unix system log.

3. Select Email Notifications options to send an email notification when specific events occur.

n TheSend email notification level specifies the types of events to email notifications for. Select
No Logging if you do not want to receive emails.

n Send email notification when logins fail sends email when login attempts fail.

n Enter theEmail send to address. All notifications are sent to this address.

n Select theEmail address type.

n Enter theEmail return address. Returned notifications are forwarded to this address.

4. SelectWrite all log messages to Startup.log to write errors to the log file.
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Setting email sending options

Select this option if you are experiencing problems and want to logmessages that occur after startup.
The log file is generally stored in the same directory as the TestTrack Server application.

5. Select Log warning if TestTrack Server is not started as an NT service to log a warning if the
server is started as an application. This option is only available if the server is running onWindows.

Most companies run the server application as a service. If it is started as an application, the
TestTrack Server is shut down by the operating system as soon as a user logs out, which can
negatively affect other users.

6. Click OK to save the settings.

Setting email sending options
Youmust enable email and configure email server settings before TestTrack users or the TestTrack
Server application can send email.

1. ChooseView > Server Options.

2. Select Sending from the Email category.

3. Select Enable sending mail via Simple Mail Transport Protocol to send email via SMTP.

n Enter the SMTP Host used to send outgoingmail. Enter an IP address (e.g., 123.34.5.26) or your
mail server’s fully qualified domain name (e.g., mail.yourcompany.com).

n Select theSSL protocol to use to encrypt communication between themail server and TestTrack
Server. You can use the SSL 3.0, TLS 1.0, Negotiate, or STARTTLS 1.0 protocols. Select <not
set> if you do not want to use a secure protocol.

n Enter thePort number. The default POP port is 995 if you select an SSL protocol and 110 if you
do not. The default IMAP port is 993 if you select an SSL protocol and 143 if you do not.

n Enter aUsername andPassword if the SMTP host requires an authenticated login. Leave these
fields empty if the host does not require authenticated login.
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Setting email tracking options

n Click Test Connection to validate the connection to themail server. The Connection Test
Results dialog box opens. If the test connection fails, you can copy and paste the text into an
email or text file and send it to your system administrator for help.

n Select Pause sending via SMTP if you are experiencing SMTP problems. Only select this
option to troubleshoot the problem because outgoingmail will back up in the queue.

n Select Only send one message per SMTP connection to send onemessage per connection.
Enable this option if the TestTrack error log contains entries stating 'The SMTP host’s reply code
to theMAIL commandwas 503' or an entry stating 'only oneMAIL per message'.

4. Click OK to save the settings.

Setting email tracking options
Email tracking saves emails sent about specific issues, requirements, requirement documents, test
cases, and test runs with the item. Users can view tracked emails on the item Overview or Email tab.

When a tracked email is sent, it includes a tracking cookie that identifies the TestTrack project, the email,
and the item it was sent from. The SMTP headers are configured to use either the user's email address or
the project email notification account email address (if the email is sent by an automation rule) as the
'From' user. The TestTrack email tracking account name is used as the 'Reply To' email address in the
SMTP header of the tracked email.

If a tracked email is replied to, the email is sent to the email tracking account specified in the 'Reply To'
SMTP header. The TestTrack Server retrieves the email from the tracking account and uses the tracking
cookie to identify the project and the email the reply was sent about. The reply email is then attached as a
reply to the original email and forwarded to the email account of the user who sent the original email.

1. ChooseView > Server Options.

2. Select Tracking from the Email category.
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Setting server options

3. Select Enable trackingmail to track emails.

Note: Use a dedicated account for email tracking purposes. All email received by the account is
imported to TestTrack and then deleted from the account. TestTrack cannot differentiate between
personal and business email.

n Select the email Protocol to use to receive tracked email. You can use POP or IMAP.

n Enter theHost IP address or domain name.

n Select theSSL protocol to use to encrypt communication between themail server and TestTrack
Server. You can use the SSL 3.0, TLS 1.0, Negotiate, or STARTTLS 1.0 protocols. Select <not
set> if you do not want to use a secure protocol.

n Enter thePort number. The default POP port is 995 if you select an SSL protocol and 110 if you
do not. The default IMAP port is 993 if you select an SSL protocol and 143 if you do not.

n Enter theUsername andPassword if the host requires an authenticated login. The TestTrack
Server uses this information to log in to the email server to retrieve tracked email. Leave these
fields empty if the host does not require authenticated login.

n Enter theReturn Email Address. This address is used to send tracked email.

n Click Test Connection to validate the connection to themail server. The Connection Test
Results dialog box opens. If the test connection fails, you can copy and paste the text into an
email or text file and send it to your system administrator for help.

4. Enter the Time to wait for initial connection response.

This is the time the TestTrack Server waits for an initial response from the email server. The valid
range is 1-32767 seconds.

5. Enter the Time to wait for other connection responses.

This is the time the TestTrack Server waits for connection responses from the email server. The valid
range is 1-32767 seconds.

6. Select Automatically remove emails without tracking cookies from the mail server to delete
emails that do not include a tracking cookie. Youmay want to select this option if the email tracking
account receives spam or other email you do not want to import into TestTrack.

7. Click OK to save the settings.

Setting server options
1. ChooseView > Server Options.

2. Select theServer category.
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Setting server database options

3. Select Encrypt messages sent between the client and server to encrypt TestTrack Server
communication with the TestTrack Client, the TestTrack Server Admin Utility, and the TestTrack
CGI applications.

Encryption increases security but may slightly affect performance.

4. Enter the port number the TestTrack Server uses to communicate with TestTrack clients.

If you change the port, make sure users update their TestTrack Server connections. The valid range
is 1-65535.

5. Enter and confirm a new password to change the Local TestTrack admin password.

If your existing administrative username and password are not recognized, you can log in using the
local TestTrack admin password. This password only provides access to server options and server
users.

We strongly recommend that you change this password. The default password, admin, is not secure
and allows any user to log in and access server options and server users.

Note: You can also use this password to correct license server communication settings if the
TestTrack Server cannot connect to the Seapine License Server.

6. Click OK to save the settings.

Setting server database options
TestTrack Server settings are stored in the server database. Each server has its own database. You can
change the location of the server database or convert the database to a different type.

1. ChooseView > Server Options.

2. Select Server Database from the Server category.

The current server database type and location are displayed.

17



Setting server database options

3. Click Change to change the database location. SeeChanging the server database, page 20.

4. Click Convert to convert the database to a different type. SeeConverting the server database,
page 18.

Converting the server database
You can convert the server database to TestTrack native, SQL Server, Oracle Native, or PostgreSQL
format. Keep the following inmind before you start the conversion:

n All other users must be logged out of the TestTrack Server.

n The destination database cannot be in use by another server.

n All of the tables in the destination databasemust be empty except for the serverid, ownerlck, and
RDBMSOptions tables.

n Legacy TestTrack 2011.1 or earlier native server databases must be upgraded or converted to
RDBMS before upgrading to the 64-bit TestTrack Server.

Note: If you are converting to a SQL Server database, we recommend that youmanually create the
server database tables. SeeSetting Up RDBMS Databases, page 51TestTrack can also create the
tables during the conversion. SeeAutomatically creating TestTrack database tables, page 46.

1. Make sure you are logged into the TestTrack Server you want to convert.

Choose File > Connect to Server to connect to a different server.

2. ChooseView > Server Options.

3. Select Server Database from the Server category.

4. Click Convert.

The TestTrack Server Database Conversion dialog box opens.
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Setting server database options

5. Select aDatabase Type. The available fields depend on the selected type.

6. Enter theConnection Information.

You are not prompted for connection information or to test the connection if you are converting to
TestTrack native format. The existing server database is moved to the old subdirectory in the
TestTrack database directory when the conversion finishes.

7. Click Test to test the connection.

The Test Connection dialog box opens and displays the results. If the test connection fails, you can
copy and paste the text into an email or text file and send it to your DBA for help.

8. Click Close to close the Test Connection dialog box.

You return to the TestTrack Server Database Conversion dialog box.

9. Click OK to convert the database.

The server database conversion information is sent to the TestTrack Server for validation.

n If the validation succeeds, you are prompted to start the conversion. Remember that users cannot
log in during the conversion process.

n If the validation fails, make sure the TestTrack tables exist and are empty, except for the serverid,
ownerlck, and RDBMSOptions tables. You should alsomake sure that all other users are logged
out of the server and that another server is not using the database.

10. Click Yes.

The conversion starts. The Conversion Status dialog box opens.

11. Click Closewhen the conversion finishes. You are prompted to use the converted server database.

12. Click Yes. Youmust stop and restart the TestTrack Server to complete the conversion.

Note: You can alsomanually change the database the TestTrack Server is using. SeeChanging
the server database, page 20.
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Setting server database options

Changing the server database
You can configure the TestTrack Server to use a different database. For example, you can change the
database if youmove it to another computer or experience problems and want to use a backup copy of the
database. You should not need to frequently change the server database.

Note:When you start the 64-bit TestTrack Server for the first time, a TestTrack native server
database is automatically created if one does not exist.

1. Make sure you are logged in to the server you want to change.

Choose File > Connect to Server to connect to a different server.

2. ChooseView > Server Options.

3. Select Server Database from the Server category.

4. Click Change.

The TestTrack Server Database Configuration dialog box opens.

5. Select aDatabase Type. The available fields change depending on the selected type.

6. Enter theConnection Information.

You are not prompted for connection information or to test the connection if you are changing to
TestTrack native format. The server automatically points to the database in the TestTrack database
directory on the server computer.

7. Click Test to test the connection.

The Test Connection dialog box opens and displays the results. If the test connection fails, you can
copy and paste the text into an email or text file and send it to your DBA for help.

8. Click Close to close the Test Connection dialog box.

You return to the TestTrack Server Database Configuration dialog box.

9. Click OK to change the database location.

The following information is verified if you selected an RDBMS database:

n The specified connection information leads to a valid RDBMS.

n A TestTrack Server application is not configured for the selected server database.
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Setting RDBMS connection options

n All of the required database tables exist and are accessible. If the database does not contain any
TestTrack tables, you are prompted to create them. SeeAutomatically creating TestTrack
database tables, page 46.

Note: If the selected server database is in use by another TestTrack Server, you can 'steal' it.
This allows you to associate a server database with a new installation of TestTrack in situations
where the TestTrack Server becomes unusable.

10. You return to the Options dialog box. Click OK to apply the changes.

Youmust stop and restart the TestTrack Server to complete the process.

Setting RDBMS connection options
You can store the TestTrack Server database and projects in a different RDBMS if you do not want to use
the TestTracknative database (SQLite). Youmust create connections to the RDBMS databases you
want to use.

1. ChooseView > Server Options.

2. Select RDBMS Connections from the Server category.

3. Click Add to add a new RDBMS connection.

The Add Connection dialog box opens.

4. Select aConnection Type. The available fields depend on the selected type.
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Setting RDBMS connection options

5. Enter the RDBMS connection information.

n Oracle—Enter theService Name of the host to connect to, Port number, andUsername and
Password.

n PostgreSQL—Enter theDatabase Name, Host Name, Port number, andUsername and
Password.

n ODBC - SQL Server—Select or enter aData Source Name (DSN). Only ODBC system DSNs
are supported. Enter theUsername andPassword. If you are usingWindows NT authentication,
leave these fields empty. The username and password of the logged in user on the TestTrack
Server computer is automatically used.

6. Enter theMinimum number of connections to specify the smallest number of connections to store
in the database connection pool.

When the TestTrack Server starts, it automatically creates the specified number of database
connections. Increasing this number can improve performance because the server will not need to
create a database connection later. If you increase this number, youmay need to purchase additional
licenses from the database vendor.

7. Enter theMaximum number of connections to specify the largest number of connections to store
in the database connection pool.

The default number of connections is 999. You should only change this number if you have a large
number of projects and are using toomany connections to the backend database.

Note: If you are using Oracle, youmay need to decrease this number tomatch the number of
Oracle connections you have licensed.

8. Click Test to validate the connection.

The Test Connection dialog box opens and displays the results. If the test connection fails, you can
copy and paste the text into an email or text file and send it to your DBA for help.

9. Click Close to close the Test Connection dialog box.

You return to the Add Connection dialog box.

10. Click OK to add the connection.

Editing RDBMS connections
You can edit the information for an RDBMS connection. If the connection is in use by active projects, or
inactive projects with logged in users, you can only change the number of connections.

1. Select theRDBMS Connections category.

2. Select a connection and click Edit.

The Edit Connection dialog box opens.

3. Make any changes and click OK.

The changes are saved.

Deleting RDBMS connections
You cannot delete an RDBMS connection if it is in use by a project.
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Setting cl ient settings

1. Select theRDBMS Connections category.

2. Select a connection then click Delete.

You are prompted to confirm the deletion.

3. Click Yes.

The connection is deleted.

Setting client settings
1. ChooseView > Server Options.

2. Select Client Settings from the Server category.

3. Select Log out floating license users if the client is inactive to log out floating license users from
the TestTrack Client if they do not interact with it for the specified number of minutes.

A warning dialog box is displayed in the TestTrack Client if users do not click themouse or use the
keyboard before the inactivity limit is reached. Users have 60 seconds to choose to stay logged in
before all windows and dialog boxes are closed and any unsaved changes are lost. The valid range of
inactivity minutes is 5-1440.

Note: Users are not logged out if the TestTrack Client is performing an action that displays a
status or progress dialog box, such as duplicating records or importing an XML file. The inactivity
timer continues when the action is complete.

4. Enter the number of minutes toKeep native client user server session active.

The TestTrack Client pings the TestTrack Server every 60 seconds. If the client cannot
communicate with the server within the specified number of minutes, the user session is terminated.
The client and server cannot communicate if the network connection is lost or if the client is closed.
The default is 240minutes.

5. Select Automatically upgrade TestTrack Clients to the current TestTrack Server version to
enable automatic upgrading of all TestTrack clients connecting to the TestTrack Server.

Enabling automatic upgrades ensures that all users are running the correct TestTrack version.

6. Enter the number of minutes of inactivity before automatically logging out TestTrack Web users.
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Setting l icense server options

TestTrack Web users are logged out if they remain on a page for the specified number of minutes
without submitting a request to the TestTrack Server. Keep inmind that closing the browser without
logging out first may not close the session and release the license. Setting the inactivity limit ensures
that licenses are eventually released. Consider increasing the timeout limit if users take a long time to
enter descriptions or other information. The valid range is 5-1440.

7. Enter the number of minutes of inactivity before automatically logging out SOAP users.

SOAP users are logged out of if they do not submit a request to the TestTrack Server within the
specified number of minutes. If the SOAP application does not call the Logout() method, the session
remains active and the license is not released. Setting the inactivity limit ensures that licenses are
eventually released.The valid range is 5-1440.

Note: SOAP users are not prompted if the period of inactivity is reached and they are logged out.

8. Click OK to save the settings.

Setting license server options
1. ChooseView > Server Options.

2. Select the License Server category.

3. Enter the License server address and port you want the TestTrack Server to connect to.

Click Find License Servers to search for available servers. See Finding license servers, page 25.

Note: If you change the license server address or port, youmust restart the TestTrack Server to
apply the changes.

4. Optionally enter a License server communications password.

The password provides additional security by preventing unauthorized users from using licenses. If
you change the Seapine License Server communications password, youmust use the same
password in TestTrack. Users cannot log in to TestTrack if the passwords do not match.

5. Select aCache Refresh Rate.
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Setting software update check options

This specifies how often the TestTrack Server checks with the license server for new users or
changes to existing users.

6. Click Test Connection to test the license server connection.

If the connection is not successful, check the address, port number, and password.

7. Click OK to save the settings.

Finding license servers
1. Select the License Server category in the Options dialog box.

2. Click Find License Servers to find all license servers on the network.

When the search is complete, the Find License Servers dialog box opens. To find servers with an
IPv6 address, select Include IPv6 in scan and click Refresh.

3. Select the license server you want to use.

4. Click Select.

The license server is selected.

Setting software update check options
You can configure TestTrack to check for updates or to notify you about beta releases. Software is not
automatically downloaded and installed.

The TestTrack Server encodes the following information and sends it to the Seapine update server, which
returns update information.

n Unique user ID—A unique ID, generated by the TestTrack Server, that is used to identify each
TestTrack Server. It does not include any information that identifies your company.

n TestTrack version—The TestTrack version installed on the TestTrack Server.

n Operating system and version—The operating system and version of the TestTrack Server computer.

n Client connections—The last time a TestTrack client connected to the server grouped by operating
system and version, by type (TestTrack client, web, SOAP, and integrations), by browser and
version, and by SCC connection.

n Licenses—The number of TestTrack Pro, TestTrack RM, and TestTrack TCM licenses on the
Seapine License Server, and if the licenses are evaluation licenses.

n Product components—Specifies if the following components are used: TestTrack Pro, TestTrack
RM, TestTrack TCM, SoloSubmit, multiple logins, stamping, email tracking, email sending, controlled
hyperlinks, RSS feeds, audit trail, and electronic signatures.

n Configuration settings—Specifies if the following items are configured: security groups, triggers,
reports, filters, custom fields, pop-upmenu values, folders, and link definitions. 

1. ChooseView > Server Options.

2. Select Auto Update Check from the Update Check category.
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Setting software update check options

3. Select Automatically check for TestTrack updates to enable the update check.

After an update check is performed, information is displayed in the Update Check category. See
Viewing software update information, page 26.

4. Select any Update Check Options.

n Enter how often TestTrack should check for updates.

n Select Send email notification for product updates to receive emails about updates. The
email includes the product version and release notes. Select the type of releases you want to be
notified about.

n Select Send notification for upcoming beta releases to be notified about beta programs.

n Enter your email information if you enabled either notification option.

5. Click OK to save the settings.

Viewing software update information
You canmanually check for TestTrack software updates or view update information after an automatic
update check is performed.

1. ChooseView > Server Options.

2. Select theUpdate Check category.
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Setting software update check options

3. Click Check for Update.

If an update is available, the release notes are displayed. To download an update, click the link to go
to Seapine’s web site.
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Managing Projects
The TestTrack Server Admin Utility is used tomanage TestTrack native and RDBMS projects. In
addition to project maintenance activities, you can also upgrade projects to the current version, convert
TestTrack native projects to RDBMS projects, and change RDBMS projects to use different databases.

Note: You should back up TestTrack projects frequently. Hard drive crashes or user error can result in
the loss of important data. It is important to perform routine backups. SeeBacking up TestTrack
databases, page 38.

About the projects list
The projects list displays project information and is the starting point for managing projects.

1. ChooseView > Projects.

The Projects dialog box opens.

Tip: If you have a large number of projects, youmay want to reorder them so themost frequently used
ones are displayed at the top of the TestTrack login dialog boxes.

Adding existing TestTrack native projects
If you removed a TestTrack native project and did not delete any of the files, you can re-add it to the
TestTrack Server.

Note: If you use the 64-bit server, youmust upgrade legacy TestTrack 2011.1 or earlier native projects
before adding them.

1. ChooseView > Projects.
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Adding exist ing TestTrack native projects

The Projects dialog box opens.

2. Click Add Existing.

The Add Existing Project dialog box opens.

3. Select TestTrack Native from the Project Type list.

4. Enter the name of theProject Directory to re-add or click Project List to select a removed project.

Projects are stored in the TTServDb/TTDbs directory in the TestTrack application directory by
default. Youmay be able to enter a full directory path depending on the server settings.

Note: The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names
of subdirectories that TestTrack creates in the specified directory.

5. Enter or change theDescription.

6. Select theProject Settings.

n Project is active creates an active project. Users cannot access inactive projects.

n Include project in Web login listmakes the project available in the TestTrack Web login list.

n Include project in Client login listmakes the project available in the TestTrack Client login list.

n Always compact the project when the TestTrack Server is started compacts the project
when the server starts. Compacting removes space and rebuilds the index files but may increase
initialization time.

n Compact the project the next time the TestTrack Server is started compacts the project the
next time the server starts.

7. Enter any project Notes.

8. Click OK.
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Adding exist ing RDBMS projects

The project is re-added to the server and displayed in the projects list.

Adding existing RDBMS projects
If you removed an RDBMS project but did not delete the records from the RDBMS database, you can re-
add it to the TestTrack Server.

When you add an existing project, youmust specify a directory to store attachments, SoloBug files, and
report stylesheets in, which are stored on the TestTrack Server and not in the database.

Note: If the project directory has not been created, youmust manually create it before adding the
project.

1. ChooseView > Projects.

The Projects dialog box opens.

2. Click Add Existing.

The Add Existing Project dialog box opens.

3. Select RDBMS from the Project Type list.

4. Select aConnection.

5. Select the project you want to add from theProject Name list.
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Edit ing project settings

Optionally select Show projects that are currently in use by other servers to add a project from a
server that is experiencing problems. You should only select a project that another server is using if
the server computer is experiencing problems and you want to move the project to another server.

6. Enter the name of theProject Directory you want to add the project files to or click Project List to
use an existing project directory.

Project directories are stored in the TTServDb/TTDbs directory in the TestTrack application directory
by default. The project directory contains subdirectories for attachments, SoloBug files, and report
stylesheets. Youmay be able to enter a full path depending on the server settings.

Note: The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names
of subdirectories that TestTrack creates in the specified directory.

7. Select theProject Settings.

n Project is active creates an active project. Users cannot access inactive projects.

n Include project in Web login list makes the project available in the TestTrack Web login list.

n Include project in Client login list makes the project available in the TestTrack Client login
list.

8. Enter any project Notes.

9. Click OK.

The project is re-added to the server and displayed in the projects list.

Editing project settings
You can edit a project's description, directory location, settings, and notes. Keep the following inmind:

n If you want to change the project directory location, youmust inactivate the project first. SeeMoving
project directories, page 32 orMoving RDBMS projects, page 33.

n If you want to change the project type, youmust convert the project. SeeConverting TestTrack 6.0
and later projects, page 42.

1. ChooseView > Projects.

The Projects dialog box opens.

2. Select the project you want to edit and click Edit.

The Edit Project dialog box opens.

3. Make any changes and click OK.

Note: If you change the project directory location, you are prompted to copy the directory to the
new location before saving the changes. Move the directory and then click Save Changes.

Moving project directories
By default, project files are located in the TTServDb\TTDbs directory in the TestTrack application
directory. The project directory includes attachments, SoloBug files, and report stylesheets. For
TestTrack native projects, the directory also includes the project database file.
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Moving RDBMS projects

You canmove project files to any directory on the server computer’s local hard drive or amapped network
drive.

Note: The following steps explain how tomove TestTrack native projects and project data stored on
the TestTrack Server for both native and RDBMS projects. SeeMoving RDBMS projects, page 33
for information about moving RDBMS projects to a different database or different TestTrack Server.

1. Inactivate the project you want to move. See Inactivating and activating projects, page 34.

2. Make a backup copy of the project directory you want to move, including all subdirectories.

By default, project directories are in the following locations:

n Windows—C:\Program Files\Seapine\TestTrack\TTServDB\TTDbs

n Mac OS X—/Applications/TestTrack/TTServDB/TTDbs

n Linux—/var/lib/TestTrack/TTServDB/TTDbs

3. Copy the project directory and all subdirectories to the new location.

4. Select the inactive project you want to move in the projects list and click Edit.

The Edit Project dialog box opens.

5. Enter the new Project Directory name or the full path to the project directory.

The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names of
subdirectories that TestTrack creates in the specified directory. The default directory path for projects
and the ability to enter fully qualified pathnames is controlled using the TestTrack Registry Utility.
See the TestTrack Registry Utility Guide
(http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf) for information.

Note: If a 'Directory name cannot contain any of the following characters' error is returned when
you save the project changes, you do not have permission to enter the full path.

6. Select Project is active to reactivate the project.

7. Make any other changes to the project information.

8. Click OK.

You are prompted tomove the project directory to the new location. Copy the project directory to the
new location if you have not already.

9. Click Save Changes.

The project is moved.

Note: See theMoving TestTrack Databases and Projects knowledgebase article
(www.seapine.com/kb/questions/1232) for troubleshooting information.

10. Optionally delete the project directory in the old location.

Moving RDBMS projects
You canmove RDBMS projects to different RDBMS databases or TestTrack Servers.
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Inactivating and activating projects

Note: For troubleshooting information, see theMoving TestTrack Databases and Projects
knowledgebase article (www.seapine.com/kb/questions/1232).

Moving projects to a different database
Projects can be hosted inmultiple RDBMS databases. This may help alleviate performance or disk space
restriction issues. Tomove a project to a different database, you need to convert it. During the
conversion, project data is copied to the destination RDBMS database and is not deleted from the original
database.

1. Inactivate the project you want to move. See Inactivating and activating projects, page 34.

2. Convert the project to copy it to the other database. SeeConverting TestTrack 6.0 and later
projects, page 42.

3. Activate the project. See Inactivating and activating projects, page 34.

4. Optionally delete the project tables from the original RDBMS database. Youmust manually delete the
project from the RDBMS unless you have permission to permanently delete RDBMS projects. Ask
your DBA for help deleting tables.

5. Repeat steps 1 - 4 for each project you want to copy to the new RDBMS database.

Moving projects to a different TestTrack Server
If you want to host an RDBMS project on a different TestTrack Server, you need tomove the project files
from the old server to the new server.

1. Inactivate the project you want to move. See Inactivating and activating projects, page 34.

2. Remove the project from the current server. SeeRemoving projects, page 35.

3. Move the project files to the new server. SeeMoving project directories, page 32.

4. Log in to the new server.

5. Add the project to the new server. SeeAdding existing RDBMS projects, page 31.

Inactivating and activating projects
Users can only access and work with active projects. You can inactivate projects that you do not want
users to access but do not want to remove.

1. ChooseView > Projects.

The Projects dialog box opens.

2. To inactivate a project, select the project and click Inactivate. The project is inactivated and
displayed in gray.

To activate a project, select the inactive project and click Activate. The project is activated and can
be accessed by TestTrack users.
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Removing projects

Removing projects
Removing projects allows you to save project data and re-add the projects in the future. When you
remove a project, users can no longer access it but the project files are not deleted.

1. Choose View > Projects.

The Projects dialog box opens.

2. Select the project you want to remove and click Remove.

You are prompted to confirm the project removal.

3. Click Yes.

The project is removed. A dialog box opens with information about the removed project.

4. Click OK to close the dialog box.

Deleting TestTrack native projects
To delete a TestTrack native project, youmust manually delete the project directory and files from the
server computer. You cannot delete these projects using the TestTrack Server Admin Utility.

Note: Youmust remove the project before it can be deleted. SeeRemoving projects, page 35.

1. Log in to the computer that hosts the TestTrack Server.

2. Delete the subdirectory that contains the project you want to delete.

By default, each TestTrack project is stored in a subdirectory of the TTServDb/TTDbs directory in the
TestTrack application directory.

Deleting RDBMS projects
To save project data, youmay want to remove projects instead of deleting them. SeeRemoving
projects, page 35.

Note: You can only delete projects if theAllow administrator to permanently destroy inactive
projects option is selected in the TestTrack Registry Utility. See the TestTrack Registry Utility Guide
(http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf) for information.

1. Choose View > Projects.

The Projects dialog box opens.

2. Select the inactive RDBMS project and click Delete.

You are prompted to confirm the deletion.

3. Click Permanently Delete to delete the project.

The local directory and all files in it are deleted. Project table entries are also deleted from the
database.

35

http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf
http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf
http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf
http://downloads.seapine.com/pub/docs/ttregistryutilityguide.pdf




Managing Databases
Each TestTrack Server has a server database, which stores configuration information for the server.
Every TestTrack project is stored in its own database, which contains all project information, including
issues, requirements, requirement documents, test cases, test runs, local customers and users, filters,
test configurations, security groups, and reports.

Whether you store the server database and projects in a TestTrack native database or RDBMS
databases, it important to regularly back up the server database and projects, and to use caution when
modifying data directly in the database.

Modifying TestTrack databases
Youmay store TestTrack data in an RDBMS database instead of the TestTrack native database format.
You canmodify the internal TestTrack database format and data from the RDBMS, but we do not
recommend it. Your TestTrack maintenance contract does not include support for recovering from these
types of database changes.

Configuration changes
For both TestTrack native databases and RDBMS databases, you can configure field names, custom
fields, workflow processes, notification rules, andmore. We recommendmaking these changes using the
TestTrack Client rather than at the database level. Making changes directly in the database requires a full
understanding of the TestTrack database format and the rules enforced at the software level.

Database table changes
Do not reconfigure the TestTrack database format. When you rename a field in the client application, the
database column names do not reflect this change. Do not change database tables/column names,
modify column size/attributes, or make any other structural database changes because it will result in
errors running TestTrack.

Live updates
TestTrack caches data to improve the performance of complex reports and filters. Do not perform live
updates of TestTrack at the database level unless the TestTrack Server has been shut down. Adding,
editing, or deleting data while the server is running results in errors and potential data loss. Your changes
may be overwritten next time the record is modified because database changes are not immediately read
into the TestTrack memory cache.

The TestTrack native database format prevents users from opening the database in read/write mode
while the TestTrack Server is running. However, TestTrack does not implement similar locks when
running against an RDBMS database. To perform live TestTrack data updates, use SOAP, bulk field
changes, or other methods available in TestTrack clients.

Note: You can read and view TestTrack information from the database via ODBC or database vendor-
specific methods.
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Backing up TestTrack databases

Backing up TestTrack databases
The TestTrack Server database and projects should be backed up regularly.

TestTrack native databases
By default, native TestTrack Server databases are stored in the following locations on the TestTrack
Server computer:

n Windows—C:\Program Files\Seapine\TestTrack\TTServDb

n Mac OS X—/Applications/TestTrack/TTServDb

n Linux—/var/lib/TestTrack/TTServDb

Projects are each stored in a subdirectory in the TTServDb directory. Keep inmind that projects may be
stored in other locations depending on your configuration.

1. Stop the TestTrack Server.

2. Copy the directories you want to back up:

n To copy the server database and all projects, copy the TTServDb directory and all subdirectories.

n To copy all projects, copy the TTDbs directory and all subdirectories.

n To copy an individual project, copy the appropriate directory in the TTDbs directory and all
subdirectories.

3. Restart the TestTrack Server.

RDBMS databases
If the TestTrack Server database or projects are stored in RDBMS databases, ask your DBA for help with
backups.

When you back up the server database and projects from the RDBMS, you should also back up the
project directories on the TestTrack Server that contain attachments, SoloBug files, and report
stylesheets. By default, these files are located in subdirectories in the TTServDb subdirectory in the
TestTrack application directory. Copy the project subdirectories to back them up.
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Upgrading and Converting Projects
Upgrading projects
You need to upgrade projects to the current format as part of the TestTrack upgrade process. See
Upgrading TestTrack 6.0 and later projects, page 39 orUpgrading TestTrack 5.0 and earlier
projects, page 39.

Converting projects
If you use TestTrack 7.0 or later, you can store data in an RDBMS, such as Oracle or Microsoft SQL
Server. Youmust convert projects to the selected format. SeeConverting TestTrack 6.0 and later
projects, page 42 orConverting TestTrack 5.0 and earlier projects, page 44.

Upgrading TestTrack 6.0 and later projects
You can upgrade projects to the current TestTrack version.

1. Choose View > Projects.

The Projects dialog box opens.

Tip: To upgrade a project that is not in the projects list, youmust first add it. SeeAdding
existing TestTrack native projects, page 29 orAdding existing RDBMS projects, page 31.

2. Select the project you want to upgrade.

You can select multiple projects. It may take several minutes to upgrade each project.

Note: If you upgrade an RDBMS project, all projects in the database are also upgraded.

3. Click Upgrade.

The Confirm Project Upgrade dialog box opens.

4. Click Yes to start the upgrade.

You return to the Projects dialog box and the upgrade starts. The Status column displays upgrade
progress information.

Upgrading TestTrack 5.0 and earlier projects
When you upgrade projects, the Seapine License Server is populated with user data. You are prompted to
select user conflict resolution options before the upgrade starts.

1. ChooseView > Projects.

The Projects dialog box opens.

Tip: To upgrade a project that is not in the projects list, youmust first add it. SeeAdding
existing TestTrack native projects, page 29.

2. Select the project you want to upgrade.
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Upgrading TestTrack 5.0 and earl ier projects

You can select multiple projects. It may take several minutes to upgrade each project.

3. Click Upgrade.

The Confirm Project Upgrade dialog box opens.

4. Select a user record conflict resolution option.

n Automatically resolve issues and log changes automatically resolves user conflicts. See
Resolving user conflicts, page 40.

n Find all issues and prompt for resolutions prompts you tomanually resolve user conflicts.
SeeResolving user conflicts, page 40.

5. Select a user demographic data conflict resolution option.

n Do not change any license server user records does not change the license server data.

n Only add data to empty license server user record fields adds user data to empty license
server record fields. Usernames and passwords are not replaced.

n Always replace license server user record fields replaces the user data on the license server.
Usernames and passwords are not replaced.

6. Click Yes to start the upgrade.

You return to the Projects dialog box. The projects list is automatically refreshed every 15 seconds
until the upgrade is complete.

Note: Youmay be prompted to resolve conflicts depending on the upgrade options you selected.

Resolving user conflicts
When you upgrade TestTrack 5.0 and earlier databases, you canmanually or automatically resolve user
conflicts.
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Upgrading TestTrack 5.0 and earl ier projects

Manually resolving conflicts
If you choose tomanually resolve conflicts, you are prompted if conflicts are found. Youmust resolve
them before the upgrade can continue.

1. The User Conflicts dialog box opens if conflicts are found.

2. Select a record and click Resolve.

The Conflict Resolution dialog box opens. An arrow is displayed next to each conflict.

3. Select a conflict resolution action.

n To create a new user, select Add as a new global user to the license server and then enter a
unique username, first name, and/or last name.

n Tomerge the license server and TestTrack data, selectMerge user information and then select
an option from the list. You can keep the license server data, replace empty license server data
with TestTrack data, or replace all license server data with TestTrack data.

n If the last name and email address are the same, select Accept user information as is to add
the TestTrack user to the license server. This option is only available if the last name/email
address are the same.

Note: You can edit most of the user data on the Seapine License Server. See the Seapine
License Server Admin Guide (http://downloads.seapine.com/pub/docs/licenseserveradmin.pdf)
for additional information.

4. Click OK.

The upgrade continues after you finish resolving all conflicts.
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Converting TestTrack 6.0 and later projects

Automatically resolving conflicts
The following information can help you understand how data is merged when you choose to automatically
resolve conflicts. In most cases, the Seapine License Server user data is retained.

n A local user has the same username as a license server user with a different first and/or last name.
The license server data is retained. If the license server user is missing data, such as an email
address or phone number, and this information is available in the project, themissing information is
added to the license server user data.

n A local user has the same first and/or last name as a license server user with a different username.
The license server data is retained. If the license server user is missing data, such as an email
address or phone number, and this information is available in the project, themissing information is
added to the license server user data. The project username is also added to that user’s history on the
license server.

n A local user has the same first name, last name, and username as a license server user. The license
server data is retained. If the license server user is missing data, such as an email address or phone
number, and this information is available in the project, themissing information is added to the license
server user data.

Note: A text file named ‘userconflictconvnotes’ is created in the TestTrack application directory. As
each project is upgraded, conflict resolution details are added to this file.

Converting TestTrack 6.0 and later projects
You can convert TestTrack 6.0 and later projects from TestTrack native to RDBMS and vice versa. If you
are converting a pre-7.0 project, you can also upgrade it as part of the conversion.

n TestTrack native projects can only be converted to RDBMS. RDBMS projects can be converted to
TestTrack native or to a different RDBMS connection.

n TestTrack 7.0 and later projects must be inactivated before they can be converted. See Inactivating
and activating projects, page 34.

n Legacy TestTrack2011.1 or earlier native projects must be upgraded or converted to RDBMS before
upgrading to the 64-bit server.

1. ChooseView > Projects.

The Projects dialog box opens.

Note: To convert a project that is not in the projects list, youmust first add it. SeeAdding
existing TestTrack native projects, page 29 orAdding existing RDBMS projects, page 31.

2. Select the project you want to convert.

You can select multiple projects. It may take several minutes to convert each project.

3. Click Convert.

The Project Destination dialog box opens.

4. If you are converting the project to RDBMS format, select aConnection and enter aProject Name
and Project Directory.
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Converting TestTrack 6.0 and later projects

You can only select one RDBMS destination. If you convert multiple projects, they are all added to
the selected RDBMS. TestTrack also automatically generates project names based on current
names. By default, projects are created in the TTServDb/TTDbs directory in the TestTrack
application directory. Youmay be able to enter a full path depending on the server settings.

Note: The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names
of subdirectories that TestTrack creates in the specified directory.

5. If you are converting the project to TestTrack native format, enter aProject Directory name.

By default, projects are created in the TTServDb/TTDbs directory in the TestTrack application
directory. Youmay be able to enter a full path depending on the server settings.

6. Click OK.

The Confirm Project Conversion dialog box opens. The available options depend on the project type.

7. Select Store file attachments and enter a file size if you are converting a TestTrack native project to
RDBMS format and want to store file attachments in the database.
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Converting TestTrack 5.0 and earl ier projects

Theminimum value is 1MB and themaximum value is 25MB. Any attachment larger than the size
you enter is stored as a file on the TestTrack Server.

8. Click Yes to start the conversion.

Note: If you converted a TestTrack 7.0 project, make sure you activate it after the conversion.

Converting TestTrack 5.0 and earlier projects
You can convert pre-6.0 TestTrack projects directly to RDBMS format. This allows you to upgrade the
projects to the current format and convert them to a different database type in one step.

Note: Legacy TestTrack2011.1 or earlier native projects must be upgraded or converted to RDBMS
format before upgrading to the 64-bit server.

1. ChooseView > Projects.

The Projects dialog box opens.

Note: To convert a project that is not in the projects list, youmust first add it. SeeAdding
existing TestTrack native projects, page 29.

2. Select the project you want to convert.

You can select multiple projects. It may take several minutes to convert each project. All selected
projects are added to the selected RDBMS.

3. Click Convert.

The Project Destination dialog box opens.

4. Select an RDBMS Connection.

5. Enter aProject Name and Project Directory.

You can only select one RDBMS destination. If you convert multiple projects, they are all added to
the selected RDBMS. TestTrack also automatically generates project names based on current
names. By default, projects are created in the TTServDb/TTDbs directory in the TestTrack
application directory. Youmay be able to enter a full path depending on the server settings.

Note: The path cannot exceed 247 characters, including the drive specifier (e.g., C:\) and names
of subdirectories that TestTrack creates in the specified directory.

44



Converting TestTrack 5.0 and earl ier projects

6. Click OK.

The Confirm Project Conversion dialog box opens.

7. Select a user record conflict resolution option.

n Automatically resolve issues and log changes automatically resolves user conflicts. See
Resolving user conflicts, page 40.

n Find all issues and prompt for resolutions prompts you tomanually resolve user conflicts.
SeeResolving user conflicts, page 40.

8. Select a user demographic data conflict resolution option.
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Automatical ly creating TestTrack database tables

n Do not change any license server user records does not change license server data.

n Only add data to empty license server user record fields adds user data to empty license
server record fields.

n Always replace license server user record fields replaces the user data on the license server.

9. Select Store file attachments in the database and enter a file size if you are converting the project
to RDBMS format and want to store file attachments in the database.

Theminimum value is 1MB and themaximum value is 25MB. Any attachment larger than the size
you enter is stored as a file on the TestTrack Server.

10. Click Yes to start the conversion.

Note: Youmay be prompted to resolve conflicts depending on the upgrade options you selected.
SeeResolving user conflicts, page 40.

Automatically creating TestTrack database tables
When you upgrade or convert projects or the server database, the physical database and empty
TestTrack Server tables must be created before the data can be converted. If the tables do not exist, you
are prompted to allow TestTrack to create the tables.

1. Select theRDBMS vendor and click OK.

2. The server loads the corresponding table creation script and sends it to the database server.

Note: The table creation scripts are stored in a configuration text file used by the TestTrack Server.
The script for each server type is stored in the configuration file, allowing DBAs to use the script for
help manually creating tables or editing database attributes.
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Working with the Server Log
The server log records TestTrack Server events, such as severe errors or unusual activity, and helps you
monitor the server’s operation.

The amount of information in the log depends on the server options you set. The server can also send
email notifications based on events. SeeSetting log options, page 13.

1. ChooseView > Server Log.

The Server Log dialog box opens.

2. Select aPage filter to filter the entries by log level. SeeServer log levels, page 48.

Select one of the following options to further narrow the log entries displayed:

n and Less Severe includes the filtered log entries plus less severe entries.

n and More Severe includes the filtered log entries plus more severe entries.

n Only limits to the filtered log entries.

Note: The read-only logged entries field displays how many entries match the selected
restrictions.

3. Select the entry you want to view.

The details are displayed in the Selected Log Entry area.
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Working with the Server Log

4. Click Save Page As to save the current page of log entries or click Save Entire Log to save all log
entries. The log is saved as a text file that can be used for analysis or report generation with other
tools.

The Export File dialog box opens. Select a Save in location, enter a File name, and click Save.

5. Click Delete All Log Entries to delete all the log entries or click Delete by Date to delete log entries
created before the specified time and date.

6. Click Closewhen you finish working with the server log.

Server log levels
The level of logging selected defines how detailed the log is. A lower level, such as Unusual Activity,
provides greater detail becausemore types of events are logged. SeeSetting log options, page 13.

Level Description

Severe
Error

An event is written to the log when a severe problem or critical condition occurs, such
as a server failure.

Error An event is written to the log when an error condition occurs, such as when a
connection attempt to a client fails.

Warning An event is written to the log when a warning condition occurs, such as RDBMS
connection problems.

Unusual
Activity

An event is written to the log when unusual activity occurs, such as a user trying to log
in with an incorrect username.

Information An event is written to the log for every significant action, such as a TestTrack Web user
timing out.

Note: Events for the selected level and all higher levels are logged. If you select Unusual Activity in
the server options, the server logs all severe error, error, warning, and unusual activity events.
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Managing Mail
Users can send email from TestTrack. TestTrack also generates email notifications. When TestTrack
sends email, it is placed in themail queue for processing by the server.

Themail queue only contains unsent emails. Email is generally sent and removed from themail queue in
less than 60 seconds. An email can get stuck in themail queue if sending is paused, the SMTP options
are not properly configured, or the SMTP host is experiencing problems.

1. ChooseView > Mail Queue.

TheMail Queue dialog box opens. Unsent emails are displayed.

2. Select an email to view the details.

The name, email address, andmail type are displayed in the recipients area. The send error is
displayed in the Errors area.

3. Click Reattempt to resend the selected email. SeeResending mail, page 49.

4. Click Delete to delete the selected email. SeeDeleting mail, page 50.

5. Click Closewhen you finish viewing themail queue.

Resending mail
1. Choose View > Mail Queue.

TheMail Queue dialog box opens.

2. Select the email you want to resend and click Reattempt.

You are prompted to confirm the resend.

3. Click Yes.

The TestTrack Server resends the email.
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Deleting mail

Note: Check the server log for errors if the email cannot be sent. SeeWorking with the Server Log,
page 47.

Deleting mail
1. ChooseView > Mail Queue.

TheMail Queue dialog box opens.

2. Select the emails you want to delete. To delete all mail in the queue, click Select All.

3. Click Delete.

You are prompted to confirm the deletion.

4. Click Yes.

The email is deleted.
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Setting Up RDBMS Databases
TestTrack projects and the server database are stored in a Relational DatabaseManagement System
(RDBMS). The TestTrack database is stored in SQLite, which is the default, native database type.
ODBC (Microsoft SQL Server), Oracle, and PostgreSQL, are also supported. Information about
supported platforms and databases is available in the TestTrack RDBMS Support knowledgebase article
(www.seapine.com/kb/questions/1527).

TestTrack native databases do not require any setup or configuration before or after installation.
PostgreSQL is also supported out of the box. If you useOracle or SQL Server, review the following
information for help setting up databases.

Note: By default, the Seapine License Server database is also stored in SQLite, but other RDBMS
types are also supported. See the Seapine License Server Admin Guide
(http://downloads.seapine.com/pub/docs/licenseserveradmin.pdf) for information about setting up
license server databases.

Setting up PostgreSQL databases
Seapine does not provide support for installing, configuring, or maintaining PostgreSQL. A qualified
PostgreSQL database administrator should install and configure the database.

Keep the following inmind:

n Do not add, delete, or modify any fields in the TestTrack tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running PostgreSQL and the TestTrack Server on the same computer can result in slow performance
if not configured properly. Make sure PostgreSQL is properly configured to avoid using all the system
memory.

Creating server database tables
The TestTrack Server automatically creates tables in PostgreSQLwhen you start the server or convert
the server database. The TTServerDB.sql script file, which is located in the PostgreSQL directory in the
TestTrack application directory, is used to create the tables.

Setting up Oracle databases
Seapine does not provide support for installing, configuring, or maintaining Oracle. A qualified Oracle
database administrator should install and configure the database and create the necessary schemas and
tablespaces.

Keep the following inmind:
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Setting up Oracle databases

n Do not add, delete, or modify any fields in the TestTrack tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running Oracle and the TestTrack Server on the same computer can result in slow performance if not
configured properly. Make sure Oracle is properly configured to avoid using all the systemmemory.

Connecting to Oracle
The recommendedmethod for using Oracle is via Oracle Call Interface (OCI). A separate installer that
includes the required Oracle Instant Client libraries can be downloaded from Seapine’s web site.

n Windows—http://downloads.seapine.com/pub/software/OracleInstantClientInstaller.exe

n Mac OS X—http://downloads.seapine.com/pub/software/oraclemacosxjavainstall.zip

n Linux—http://downloads.seapine.com/pub/software/oraclelinuxjavainstall.tar.gz

Creating database tables
The TestTrack Server automatically creates tables when you start the server or convert the server
database. The TTServerDB.sql script file, which is located in the Oracle directory in the TestTrack
application directory, is used to create the tables.

Creating Oracle users
Youmust create anOracle user for the TestTrack Server. The user only requires default connection
privileges and should not have any Oracle DBA privileges. Use your preferred tablespacemanagement
for the users. An easy method is to set up the user to share the USERS tablespace and to enable an
unlimited quota.

Database character set
Oracle only converts characters when theOracle client’s character set, specified by NLS_LANG, does
not match the character set stored in the database. If the character set is not UTF-8, VARCHAR2 fields
may not be able to correctly store data. If this happens, the followingmisnomer of an error is returned:
‘ORA-01461: can bind a LONG value only for insert into a LONG column’. TheOracle database character
set should be AL32UTF8 or UTF8.

Sizing, memory, and tuning
Oracle sizing and tuning settings should be consistent with your corporate standards. Review the SQL
scripts for schema creation installed with TestTrack Server to determine the appropriate settings.
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Setting up SQL Server databases

Setting up SQL Server databases
Seapine does not provide support for installing, configuring, or maintaining SQL Server. A qualified SQL
Server database administrator should install and configure the database.

Keep the following inmind:

n Do not add, delete, or modify any fields in the TestTrack tables.

n Do not directly add, edit, or delete any data in the tables.

n Do not create different primary keys. This will adversely affect application performance.

n Do not create complex triggers on any of the tables. Triggers may cause severe database issues and
correcting these issues is not covered by Seapine Software.

n Create a process to back up database tables on a regular schedule.

n Running SQL Server and the TestTrack Server on the same computer can result in slow performance
if not configured properly. Make sure SQL Server is properly configured to avoid using all the system
memory.

Note: Youmust be amember of the db_ddladmin role and have the CREATE TABLE, CREATE
PROCEDURE, and CREATE VIEW permissions to create the TestTrack tables.

Connecting to SQL Server
The only supportedmethod for using SQL Server is via anODBC connection. Use theODBC Data
Source Administrator to add a SQL Server data source name (DSN) on the TestTrack computer.

n SQLServer must contain a TestTrack database before you create the DSN.

n Youmust use a system DSN.

n Make sure you change the default database to the TestTrack database. Do not use themaster
database.

n Make sure theUse ANSI quoted identifiers, ANSI nulls, padding, and warnings, andPerform
translation for character data options are selected.

Creating server database tables
The TestTrack Server automatically creates tables when you start the server or convert the server
database. The TTServerDB.sql script file, which is located in the SQLServer directory in the TestTrack
application directory, is used to create the tables.

Troubleshooting RDBMS connections
The following information can help you troubleshoot commonRDBMS issues. Refer to the database
vendor documentation for additional help.

Note: If the TestTrack Server cannot connect to the server database, errors are added to the
Startup.log file in the TestTrack application directory.
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Troubleshooting RDBMS connections

Server database cannot be shared
The Seapine License Server, Surround SCM Server, and TestTrack Server store server configuration
information in a server database. The server databases cannot be located in the sameRDBMS database.

Dropped tables or change database configuration
Youmust stop and restart the TestTrack Server if you drop server or tables from anRDBMS and need to
re-create them. Youmust also stop and restart the server if you reconfigure the destination database in
the ODBC Data Source Administrator.

The TestTrack Server caches data from the database. If the underlying database is modified, the cached
data no longer matches the data in the database. The connection fails if the server identifies that the
backend database is different and the following error is logged: 'The server failed to initialize a connection
for XYZ. The destination RDBMS database was changed'.

Mismatched UUID affects server database lock
This error occurs when the database is in use by a different TestTrack Server. You are prompted to
reconfigure the database. Do not reconfigure the database if it is used on a different computer. Youmust
manually modify the TestTrack Server connection information to point to a different database and restart
the server. If the database is no longer in use by a different server, reconfigure the database connection
information to allow the current TestTrack Server access to the database.

ODBC connection issues
Try the following if you are experiencing ODBC connection problems.

1. Test the ODBC connection in the ODBC Data Source Administrator.

If you cannot connect to the RDBMS, click the Test Connection button in the ODBC Data Source
Administrator to test the connection.

2. Make sure the DSN is a system DSN.

The data source you are trying to connect to must be configured as a system DSN in the ODBC Data
Source Administrator. The TestTrack Server Admin Utility only displays system DSNs.

ODBC connection errors

Error Cause

[Microsoft][ODBC Driver Manager] Data
source name not found and no default driver
specified QODBC3: Unable to connect

AnODBC data source with the specified DSN was
not set up in the ODBC Data Source Administrator.
The DSN must be a system DSN.
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Troubleshooting RDBMS connections

SQL Server connection errors

Error Cause

[Microsoft][ODBC SQLServer
Driver][SQL Server]Login failed for user
'(null)'. Reason: Not associated with a
trusted SQL Server connection.
QODBC3: Unable to connect

Occurs onWindows. A username is not specified for the
RDBMS connection and theODBC data source was not
configured to run ‘WithWindows NT authentication using
the network login ID’ in the ODBC Data Source
Administrator.

[Microsoft][ODBC SQLServer
Driver][SQL Server]Login failed for user
'xxxx'. QODBC3: Unable to connect

The username or password entered in the RDBMS
connection information is not valid.

Oracle connection errors

Error Cause

ORA-06401:
NETCMN: invalid
driver designator
QOCI: Unable to logon

TheOracle Instant client drivers are not installed. SeeSetting up Oracle
databases, page 51 for information about downloading the installers.

ORA-12705: invalid or
unknownNLS
parameter value
specified QOCI:
Unable to logon

The full Oracle client is installed on the same computer with a language
setting other than UTF8. To resolve this issue, set the following environment
variable:

n Windows—NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252

n Linux andMac OS X—NLS_LANG=American_America.UTF8

You can also remove the following registry entry to help resolve the issue:
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\NLS_LANG

Note: Refer to Oracle Metalink article 179133.1, “The Correct NLS_LANG
in aWindows Environment,” for information about the correct setting,
which varies based on theWindows version.

ORA-12514:
TNS:listener does not
currently know of
service requested in
connect descriptor
QOCI: Unable to logon

The service name specified in the RDBMS connection information does not
exist. Make sure that an Oracle listener was created with the specified
service name on the host computer.

This error can also occur if a version of the full Oracle client older than 10g is
installed. If the full client appears in the PATH environment variable, the
older oci.dll may be loaded. To resolve this issue, search for all instances of
the oci.dll file. If multiple copies are found, remove the other copies or
remove their directory reference from the PATH environment variable.
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Troubleshooting RDBMS connections

Error Cause

ORA-12154:
TNS:could not resolve
the connect identifier
specified QOCI:
Unable to logon

The computer specified in the RDBMS connection host name cannot be
found. Make sure the host name is correct and the host computer is running.

ORA-12541: TNS:no
listener QOCI: Unable
to logon

The port number specified in the RDBMS connection information is not a
valid TNS listener port on the specified host computer. Check the host port
number.

ORA-01017: invalid
username/password;
logon denied QOCI:
Unable to logon

The username or password specified in the RDBMS connection information
is not valid. Check the username and password.

PostgreSQL connection errors

Error Cause

Opening the database connection failed because the
TestTrack Server could not connect to the server or
translate the host name

The TestTrack Server cannot connect to the
PostgreSQL service. Check the following and
then restart the server:

n The PostgreSQL service is running.

n The host name and port number are
correct.

n A firewall is not blocking the port.

n If connecting to a remote PostgreSQL
server, the server is configured to accept
remote connections.
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